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Glossary  
A glossary of terms used in this document. 

Terms Definition 

ASCII American Standard Code for Information Interchange. 

BSP 
Board Support Package, the layer of software containing hardware-specific drivers and libraries to function 
in a particular hardware environment. 

DUT Design Under Test. 

CDT C/C++ Development Tools. 

CPU Central Processing Unit. 

GUI Graphical User Interface. 

FPGA Field Programmable Gate Array. 

HDL Hardware description language. 

IBIS Input Output Buffer Information System. 

IDE Integrated Development Environment. 

IP Intellectual Property. 

JEDEC Joint Electron Device Engineering Council. 

OCD On-Chip-Debugging. 

OEM Original Equipment Manufacturer. 

OpenOCD Open On-Chip Debugger.  

Perspective A group of views and editors in the Workbench window. 

Programmer 
A tool can program Lattice FPGA SRAM and external SPI Flash through various interfaces, such as JTAG, SPI, 

and I2C.  

RISC-V 
Reduced Instruction Set Computer-V. A free and open instruction set architecture (ISA) enabling a new era 
of processor innovation through open standard collaboration. 

RISC-V MC Lattice RISC-V for Micro-Controller Soft IP.  

RISC-V SM Lattice RISC-V for State-Machine Soft IP. 

RISC-V RX Lattice RISC-V for RTOS Soft IP. 

SDK 
Software Development Kit. A set of software development tools that allows the creation of applications for 
software package on the Lattice embedded platform. 

SoC 
System-on-Chip. An integrated circuit that integrates all components of a computer or other electronic 
systems. 

SRAM Static Random Access Memory. 

UART Universal Asynchronous Receiver/Transmitter. 

UI User Interface. 

UFM User Flash Memory. 

VHDL Very-High-Speed Integrated Circuit Hardware Description Language. 

Workspace 
The directory where stores your work, it is used as the default content area for your projects as well as for 
holding any required metadata. 

Workbench The desktop development environment in Eclipse IDE platform. 
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1. Introduction 
Lattice Propelϰ is a complete set of graphical and command-line tools to create, analyze, compile, and debug both 
FPGA-based hardware and software processor systems. 

1.1. Purpose 
Embedded system solutions play an important role in FPGA system design, allowing you to develop software for a 
processor in an FPGA device. It provides the flexibility for you to control various peripherals from a system bus.  

To develop an embedded system on an FPGA, you need to design the System-on-Chip (SoC) with an embedded 
processor and develop system software on the processor. Lattice Propel helps you develop your system with a RISC-V 
processor, peripheral IP, and a set of tools.  

The purpose of this document is to introduce Lattice Propel SDK tool and flow to help you quickly get started to build a 
small demo system. You can find recommended flows of using Lattice Propel SDK in this document as well.  

1.2. Audience 
The intended audience for this document includes embedded system designers and embedded software developers 
using Lattice FPGA devices. The complete list of supported devices can be found in Lattice Propel Release Notes. The 
technical guidelines assume readers have expertise in the embedded system area and FPGA technologies. 

 

http://www.latticesemi.com/legal


Lattice Propel 2023.1 SDK  
User Guide 
 

©  2023 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal. 
 All other brand or product names are trademarks or registered trademarks of their respective holders. The specifications and information herein are subject to change without notice. 

8  FPGA-UG-02186-1.0 

2. Lattice Propel Development Suite 
Lattice Propel development suite includes: 

¶ an integrated development environment (IDE), which is the framework of Propel;  

¶ Lattice Propel Builder, which is for SoC design;  

¶ Lattice Propel SDK, which is for system software development. 

2.1. Eclipse IDE 
Eclipse IDE provides the Propel development suite a platform to manage the SoC project and the Embedded C/C++ 
Project in the same workspace.  

The SoC project, which extends from the Propel Builder project, provides easy interaction with other Lattice design 

tools, such as Lattice DiamondÑ within Propel. 

The Embedded C/C++ Project provides a platform for developing or debugging application code within Eclipse IDE. The 
project can be created directly from the SoC project with a pre-set Board Support Package (BSP) and applications by 
using Propel development suite. 

2.2. Lattice Propel Builder 
Lattice Propel Builder allows you to assemble the larger functional blocks of the design hierarchy. Propel Builder 
enables you to instantiate modules and IP from the IP Catalog in a schematic view, and can easily connect the modules. 
Propel Builder also helps you customize address spaces within modules, such as a processor. In Propel development 
suite, Propel Builder is used to create a microprocessor integrated platform for both hardware and software 
development.  

Refer to Lattice Propel 2023.1 Builder User Guide (FPGA-UG-02185) for more detailed information. 

2.3. Lattice Propel SDK  
Lattice Propel SDK is based on Eclipse Embedded C/C++ Development Tools (CDT). It allows you to create, build, and 
debug software application projects that drive the platform within the Eclipse framework. 

The main features are: 

¶ Create, build, debug, or manage embedded applications for Lattice RISC-V CPU/SoC solution. 

¶ Provide extra build steps to generate the binary and memory files required for deployment. 

¶ Build using the latest industry standard open source components and tools for RISC-V firmware development and 
debugging. 

¶ Support Picolibc for RISC-V, and provide lightweight standard library implementation. 

¶ Provide fully-configurable toolchain definitions. 
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3. Lattice Propel Tool Flows 
The Propel tool flows including SoC project design flow, C/C++ project design flow, system simulation flow, and 
programming and On-Chip-Debugging (OCD) debugging flow, are discussed in detail in the following sections. 

3.1. Propel Environment 

3.1.1. Running Lattice Propel 

After installing Lattice Propel, you can launch Propel from the desktop shortcut icon or from the Windows Start menu. 
When Propel is invoked, a dialog (Figure 3.1) pops up. You can browse to select where to locate the workspace. For 
normal needs, just click Launch to pick the default location and continue running Propel. 

 

Figure 3.1. Select Workspace Dialog 

After the workspace location is chosen, a single workbench window is displayed using default Propel SDK perspective. 
The default Propel SDK perspective contains the following five functional areas (Figure 3.2). 

1. aŜƴǳ ōŀǊ ŀƴŘ ¢ƻƻƭōŀǊΦ 

2. tǊƻƧŜŎǘ 9ȄǇƭƻǊŜǊ ǾƛŜǿΥ ŘƛǎǇƭŀȅǎ ǇǊƻƧŜŎǘǎ ƛƴ ǘƘŜ ǿƻǊƪǎǇŀŎŜΦ 

3. 9ŘƛǘƻǊ ǾƛŜǿΥ ǇǊƻǾƛŘŜǎ ŎŀǇŀōƛƭƛǘȅ ƻŦ ŜŘƛǘƛƴƎ ǎƻǳǊŎŜ ŦƛƭŜǎΦ 

4. hǳǘƭƛƴŜ ǾƛŜǿΥ ŘƛǎǇƭŀȅǎ ŀƴ ƻǳǘƭƛƴŜ ƻŦ ŀ ŦƛƭŜ ǘƘŀǘ ƛǎ ŎǳǊǊŜƴǘƭȅ ƻǇŜƴ ƛƴ ǘƘŜ ŜŘƛǘƻǊ ŀǊŜŀΦ 

5. [ƻƎ ŀǊŜŀ ƛƴŎƭǳŘŜǎ ǘƘŜǎŜ ǾƛŜǿǎΥ tǊƻōƭŜƳ ǾƛŜǿΣ ¢ŀǎƪǎ ǾƛŜǿΣ /ƻƴǎƻƭŜ ǾƛŜǿΣ tǊƻǇŜǊǘƛŜǎ ǾƛŜǿΣ ŀƴŘ ¢ŜǊƳƛƴŀƭ ǾƛŜǿΦ  
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Figure 3.2. Propel Workbench Window 

3.1.2. Importing General Projects 

In Propel SDK, you can use the importing project wizard to import existing projects into workspace except for Lattice 
SoC design created by Lattice Propel Builder. 

Note: You can only import projects which are created or managed by Propel SDK by choosing General > Existing Project 
into Workspace in Propel SDK. 

1. Lƴ [ŀǘǘƛŎŜ tǊƻǇŜƭ ό{5YύΣ ŎƘƻƻǎŜ CƛƭŜ Ҕ LƳǇƻǊǘΧΦ  

The Select wizard opens (Figure 3.3). 

2 3 

1 

4 

5 

http://www.latticesemi.com/legal


 Lattice Propel 2023.1 SDK 
 User Guide 
 

©  2023 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal.  
All other brand or product names are trademarks or registered trademarks of their respective holders. The specifications and information herein are subject to change without notice. 

FPGA-UG-02186-1.0  11 

 

Figure 3.3. Import Projects Wizard τ General 

2. {ŜƭŜŎǘ DŜƴŜǊŀƭ Ҕ 9ȄƛǎǘƛƴƎ tǊƻƧŜŎǘ ƛƴǘƻ ²ƻǊƪǎǇŀŎŜΦ /ƭƛŎƪ bŜȄǘΦ 

The Import wizard switches to Import Projects wizard (Figure 3.4). 
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Figure 3.4. Import Existing Projects Wizard 

3. /ƘƻƻǎŜ ŜƛǘƘŜǊ {ŜƭŜŎǘ Ǌƻƻǘ ŘƛǊŜŎǘƻǊȅ ƻǊ {ŜƭŜŎǘ ŀǊŎƘƛǾŜ ŦƛƭŜΣ ŎƭƛŎƪƛƴƎ ǘƘŜ ŀǎǎƻŎƛŀǘŜŘ .ǊƻǿǎŜ ōǳǘǘƻƴ ǘƻ ƭƻŎŀǘŜ ǘƘŜ 
ŘƛǊŜŎǘƻǊȅ ƻǊ ŦƛƭŜ ŎƻƴǘŀƛƴƛƴƎ ǘƘŜ ǇǊƻƧŜŎǘΦ 

4.  {ŜƭŜŎǘ ǘƘŜ ǇǊƻƧŜŎǘ ƻǊ ǇǊƻƧŜŎǘǎ ȅƻǳ ǿŀƴǘ ǘƻ ƛƳǇƻǊǘ ƛƴ ǘƘŜ tǊƻƧŜŎǘǎ ŀǊŜŀΦ 

5. .Ŝ ǎǳǊŜ ǘƻ ŎƘŜŎƪ ǘƘŜ /ƻǇȅ ǇǊƻƧŜŎǘǎ ƛƴǘƻ ǿƻǊƪǎǇŀŎŜ ƻǇǘƛƻƴ ǎƻ ǘƘŀǘ ȅƻǳǊ ƻǊƛƎƛƴŀƭ ǇǊƻƧŜŎǘǎ Řƻ ƴƻǘ ƎŜǘ ǳǇŘŀǘŜŘΦ 

6. /ƭƛŎƪ CƛƴƛǎƘ ǘƻ ǎǘŀǊǘ ǘƘŜ ƛƳǇƻǊǘƛƴƎ ǇǊƻŎŜǎǎΦ  

3.1.3. Importing Lattice SoC Design Projects 

In Propel SDK, you can use the Import Wizard to import Lattice SoC design projects into workspace. Existing SoC design 
projects created by either Propel SDK or Propel Builder can also be imported into Workspace by choosing Lattice 
Propel > Lattice SoC Design Projects.  

1. From Lattice Propel SDK, choose File > LƳǇƻǊǘΧ.  

The Select wizard opens (Figure 3.5). 
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Figure 3.5. Import Projects Wizard ς Lattice Propel 

2. Select Lattice Propel > Lattice SoC Design Projects into Workspace. Click Next. 

The Select wizard switches to Import Lattice SoC Design Projects wizard page (Figure 3.6). 

 

Figure 3.6. Import Lattice SoC Design Projects Wizard 

3. Locate the directory containing the projects by clicking the Browse button. 

4. In Projects area, select the SoC design project or projects you want to import. 

5. Click Finish to start the importing process. 
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3.2. SoC Project Design Flow 
A new SoC design project including a Propel Builder design can be started from the Lattice Propel sets. Follow the steps 
below to create a new SoC design project. 

3.2.1. Creating a SoC Design Project 

To start a Lattice SoC Design Project from Propel: 

1. Lƴ [ŀǘǘƛŎŜ tǊƻǇŜƭΣ ŎƘƻƻǎŜ CƛƭŜ Ҕ bŜǿ Ҕ    [ŀǘǘƛŎŜ {ƻ/ 5ŜǎƛƎƴ tǊƻƧŜŎǘΦ  

¢ƘŜ /ǊŜŀǘŜ {ƻ/ tǊƻƧŜŎǘ ǿƛȊŀǊŘ ƻǇŜƴǎ όCƛƎǳǊŜ оΦтύΦ   

 

Figure 3.7. Create SoC Project Wizard 

2. 9ƴǘŜǊ ŀ ǇǊƻƧŜŎǘ ƴŀƳŜΦ  

Note: Do not include periods, colons, or spaces in the project name. 

3. όhǇǘƛƻƴŀƭύ ¢ƻ ŎƘŀƴƎŜ ǘƘŜ ŘŜŦŀǳƭǘ ƭƻŎŀǘƛƻƴΣ ŎƭŜŀǊ ǘƘŜ ¦ǎŜ ŘŜŦŀǳƭǘ ƭƻŎŀǘƛƻƴ ƻǇǘƛƻƴΣ ǘƘŜƴ ōǊƻǿǎŜ ŦƻǊ ŀƴƻǘƘŜǊ ƭƻŎŀǘƛƻƴΦ 
/ƘƻƻǎŜ ŀ ŦƛƭŜ ǎȅǎǘŜƳΦ 

4. {ŜƭŜŎǘ ŀ ŘŜǎƛǊŜŘ ǇƭŀǘŦƻǊƳ ǘŜƳǇƭŀǘŜ ŘŜǎƛƎƴΦ Lƴ ǇŀǊǘƛŎǳƭŀǊΣ ǎŜƭŜŎǘ ŜƳǇǘȅ ǇǊƻƧŜŎǘ ŦƻǊ ōǳƛƭŘƛƴƎ ǎȅǎǘŜƳ ŦǊƻƳ ǎŎǊŀǘŎƘΦ 

5. /ƭƛŎƪ CƛƴƛǎƘΦ 

The SoC design project is created in workbench, and its design is opened and displayed in Propel Builder  
(Figure 3.10).  
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3.2.2. Open a SoC Design in Propel Builder 

Within a SoC project, there is a Propel builder design.  

To open Propel Builder for a SoC project: 

1. Lƴ ǘƘŜ tǊƻƧŜŎǘ 9ȄǇƭƻǊŜǊ ǾƛŜǿΣ ǎŜƭŜŎǘ ŀ {ƻ/ ǇǊƻƧŜŎǘΦ 

2. hǇŜƴ ǘƘŜ {ƻ/ ǇǊƻƧŜŎǘ ƛƴ ƻƴŜ ƻŦ ǘƘŜ ŦƻƭƭƻǿƛƴƎ ǿŀȅǎ ŦǊƻƳ tǊƻǇŜƭΥ  

¶ /ƘƻƻǎŜ [ŀǘǘƛŎŜ¢ƻƻƭǎ Ҕ  hǇŜƴ 5ŜǎƛƎƴ ƛƴ tǊƻǇŜƭ .ǳƛƭŘŜǊ όCƛƎǳǊŜ оΦуύΦ 

  

Figure 3.8. LatticeTools Menu 

¶ /ƭƛŎƪ ǘƘŜ tǊƻǇŜƭ .ǳƛƭŘŜǊ ƛŎƻƴ  ƻƴ ǘƘŜ ǘƻƻƭōŀǊΦ  

¶ wƛƎƘǘπŎƭƛŎƪ ǘƘŜ {ƻ/ ǇǊƻƧŜŎǘ ŦǊƻƳ tǊƻƧŜŎǘ 9ȄǇƭƻǊŜǊΦ /ƘƻƻǎŜ hǇŜƴ 5ŜǎƛƎƴ Lƴ Ҕ  tǊƻǇŜƭ .ǳƛƭŘŜǊ ŦǊƻƳ ǘƘŜ ǇƻǇǳǇ 
ƳŜƴǳ όCƛƎǳǊŜ оΦфύΦ  

  

Figure 3.9. Project Explorer Popup Menu 

3. ¢ƘŜ {ƻ/ 5ŜǎƛƎƴ ƛǎ ƻǇŜƴŜŘ ŀƴŘ ŘƛǎǇƭŀȅŜŘ ƛƴ tǊƻǇŜƭ .ǳƛƭŘŜǊ όCƛƎǳǊŜ оΦмлύΦ 

 

Figure 3.10. Propel Builder Window 
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4. όhǇǘƛƻƴŀƭύ aƻŘƛŦȅ ǘƘŜ ŘŜǎƛƎƴ ƛƴ tǊƻǇŜƭ .ǳƛƭŘŜǊ ŀǎ ŘŜǎƛǊŜŘΦ aƻǎǘ ƻŦ ǘƘŜ ǘŜƳǇƭŀǘŜǎ ƛƴŎƭǳŘŜ ŀ ŦǳƴŎǘƛƻƴŀƭπǊŜŀŘȅ {ƻ/ 
ŘŜǎƛƎƴΦ  

Note: You can only create a SoC design using Empty Project template inside the Propel Builder. Refer to  
Lattice Propel Builder 2023.1 User Guide (FPGA-UG-02185) for more details on how to create a SoC design using 
Empty Project template.  

3.2.3. Open Design in Lattice FPGA Design Software 

Within a SoC project, you can create a Lattice FPGA design project including a Propel Builder design, and then open the 
FPGA design project in appropriate software. There are two FPGA Design Software available, Lattice Diamond and 
Lattice Radiantϰ. Depending on the device family used in the SoC project, only one of the FPGA Design software can be 
selected from the User Interface (UI), the other is grayed out. If the MachXO3D or LFMNX device family is used, the 
Lattice Diamond related menu items are active from Propel UI. If the LIFCL or LFD2NX device family is used, the Lattice 
Radiant related menu items are active from Propel UI. 

To open FPGA Design Software for a SoC project from Propel: 

1. όhǇǘƛƻƴŀƭύ {Ŝǘ [ŀǘǘƛŎŜ CtD! ŘŜǎƛƎƴ ǎƻŦǘǿŀǊŜ ƛƴǎǘŀƭƭŀǘƛƻƴ ƭƻŎŀǘƛƻƴ ŦǊƻƳ tǊƻǇŜƭΦ .ȅ ŘŜŦŀǳƭǘΣ tǊƻǇŜƭ Ŏŀƴ ŦƛƴŘ ǘƘŜ ǇǊƻǇŜǊ 
[ŀǘǘƛŎŜ CtD! ŘŜǎƛƎƴ ǎƻŦǘǿŀǊŜ ƛƴǎǘŀƭƭŀǘƛƻƴ ƭƻŎŀǘƛƻƴΣ ǳǎǳŀƭƭȅ ǘƘŜ ƭŀǘŜǎǘ ǾŜǊǎƛƻƴ ƛƴǎǘŀƭƭŜŘ ƻƴ ǘƘŜ t/Φ ¸ƻǳ Ŏŀƴ ƻǾŜǊǿǊƛǘŜ 
ƛǘ ŦƻƭƭƻǿƛƴƎ ǎǘŜǇǎΦ    

Choose Window > Preferences. The Preferences dialog opens (Figure 3.11). 

Select Propel Setting from the left pane. Click the Browse button to pick up the installation location of Diamond or 
Radiant. Or, leave the Radiant Location and Diamond Location fields blank, as default. Propel can find the location 
automatically. 

 

Figure 3.11. Propel Preferences Dialog 

2. Lƴ ǘƘŜ tǊƻƧŜŎǘ 9ȄǇƭƻǊŜǊ ǾƛŜǿ ŦǊƻƳ ǘƘŜ tǊƻǇŜƭ Ƴŀƛƴ DǊŀǇƘƛŎŀƭ ¦ǎŜǊ LƴǘŜǊŦŀŎŜ όD¦LύΣ ǎŜƭŜŎǘ ŀ {ƻ/ ǇǊƻƧŜŎǘΦ  

3. hǇŜƴ ǘƘŜ {ƻ/ ǇǊƻƧŜŎǘ ƛƴ ƻƴŜ ƻŦ ǘƘŜ ŦƻƭƭƻǿƛƴƎ ǿŀȅǎΥ  

¶ /ƘƻƻǎŜ [ŀǘǘƛŎŜ¢ƻƻƭǎ Ҕ DŜƴŜǊŀǘŜ ŀƴŘ hǇŜƴ 5ƛŀƳƻƴŘ tǊƻƧŜŎǘΤ hǊΣ ŎƘƻƻǎŜ [ŀǘǘƛŎŜ¢ƻƻƭǎ Ҕ DŜƴŜǊŀǘŜ ŀƴŘ 
hǇŜƴ wŀŘƛŀƴǘ tǊƻƧŜŎǘΦ 

¶ /ƭƛŎƪ ǘƘŜ 5ƛŀƳƻƴŘ ƛŎƻƴ  ƻǊ ǘƘŜ wŀŘƛŀƴǘ ƛŎƻƴ ŦǊƻƳ ǘƘŜ ǘƻƻƭōŀǊΦ 
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¶ wƛƎƘǘπŎƭƛŎƪ ŀ {ƻ/ ǇǊƻƧŜŎǘ ŦǊƻƳ ǘƘŜ tǊƻƧŜŎǘ 9ȄǇƭƻǊŜǊΦ /ƘƻƻǎŜ hǇŜƴ 5ŜǎƛƎƴ Lƴ Ҕ 5ƛŀƳƻƴŘΦ hǊΣ ŎƘƻƻǎŜ hǇŜƴ 

5ŜǎƛƎƴ Lƴ Ҕ wŀŘƛŀƴǘ ŦǊƻƳ ǘƘŜ ǊƛƎƘǘπŎƭƛŎƪ ƳŜƴǳΦ  

4. ¢ƘŜ 5ƛŀƳƻƴŘκwŀŘƛŀƴǘ ǇǊƻƧŜŎǘ ŦƻǊ {ƻ/ ƛǎ ƎŜƴŜǊŀǘŜŘ ŀǘ ōŀŎƪƎǊƻǳƴŘ ŀƴŘ ƛǎ ƭŀǳƴŎƘŜŘ όCƛƎǳǊŜ оΦмнκCƛƎǳǊŜ оΦмоύΦ 

 

Figure 3.12. Diamond Project 

 

Figure 3.13. Radiant Project 
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5. όhǇǘƛƻƴŀƭύ CǊƻƳ ǘƘŜ CƛƭŜ [ƛǎǘ ǾƛŜǿ ƻŦ ǘƘŜ 5ƛŀƳƻƴŘκwŀŘƛŀƴǘ ǎƻŦǘǿŀǊŜΥ 

¶ ƳƻŘƛŦȅ ǘƘŜ ǘƻǇπƭŜǾŜƭ w¢[ ŦƛƭŜ όғǇǊƻƧψƴŀƳŜҔψ¢ƻǇΦǾύ ǘƻ ƳŀǘŎƘ ǘƘŜ {ƻ/ ŘŜǎƛƎƴΣ ǇǊŜǎǳǇǇƻǎƛǘƛƻƴ ƻŦ ǿƘƛŎƘ ƛǎ ǘƘŀǘ 
ǘƘŜǊŜ ƛǎ ŀ ǘƻǇπƭŜǾŜƭ w¢[ ŦƛƭŜ ƛƴ ȅƻǳǊ {ƻ/ ŘŜǎƛƎƴΤ ƻǊ 

¶ ŎǊŜŀǘŜ ŀ ǘƻǇπƭŜǾŜƭ w¢[ ŦƛƭŜ όғǇǊƻƧψƴŀƳŜҔψ¢ƻǇΦǾύ ǘƻ ƳŀǘŎƘ ǘƘŜ {ƻ/ ŘŜǎƛƎƴΣ ƛŦ ǘƘŜ {ƻ/ ŘŜǎƛƎƴ ƛǎ ŎǊŜŀǘŜŘ ŦǊƻƳ ŀƴ 
9ƳǇǘȅ tǊƻƧŜŎǘ ǘŜƳǇƭŀǘŜ ŀƴŘ ǘƘŜǊŜ ƛǎ ƴƻ ǘƻǇπƭŜǾŜƭ w¢[ ŦƛƭŜ ƛƴ ȅƻǳǊ {ƻ/ ŘŜǎƛƎƴΦ  

6.  όhǇǘƛƻƴŀƭύ aƻŘƛŦȅ ŎƻƴǎǘǊŀƛƴǘ ŦƛƭŜ όғǇǊƻƧψƴŀƳŜҔΦƭǇŦκғǇǊƻƧψƴŀƳŜҔΦǇŘŎύ ǘƻ ƳŀǘŎƘ ǘƘŜ {ƻ/ ŘŜǎƛƎƴΣ ƛŦ ȅƻǳ ƘŀǾŜ 
ƳƻŘƛŦƛŜŘ ǘƘŜ {ƻ/ ŘŜǎƛƎƴΦ  

bƻǘŜΥ ¢Ƙƛǎ ǎǘŜǇ ƛǎ ŀ Ƴǳǎǘ ŦƻǊ ǘƘŜ {ƻ/ ŘŜǎƛƎƴ ŎǊŜŀǘŜŘ ŦǊƻƳ ǘƘŜ 9ƳǇǘȅ tǊƻƧŜŎǘ ǘŜƳǇƭŀǘŜΦ 

7. tǊƻŎŜǎǎ ǘƘŜ ŘŜǎƛƎƴ ƛƴ [ŀǘǘƛŎŜ 5ƛŀƳƻƴŘκwŀŘƛŀƴǘΦ 

Lƴ 5ƛŀƳƻƴŘ ǎƻŦǘǿŀǊŜΣ ǎǿƛǘŎƘ ǘƻ tǊƻŎŜǎǎ ǾƛŜǿ ƻŦ ǘƘŜ ǇǊƻƧŜŎǘ όCƛƎǳǊŜ оΦмпύΦ aŀƪŜ ǎǳǊŜ ŀǘ ƭŜŀǎǘ ƻƴŜ ŦƛƭŜΣ L.L{ aƻŘŜƭΣ 
±ŜǊƛƭƻƎ {ƛƳǳƭŀǘƛƻƴ CƛƭŜΣ ±I5[ {ƛƳǳƭŀǘƛƻƴ CƛƭŜΣ .ƛǘǎǘǊŜŀƳ CƛƭŜΣ ƻǊ W959/ ŦƛƭŜΣ ƛǎ ŎƘŜŎƪŜŘ ƛƴ ǘƘŜ 9ȄǇƻǊǘ CƛƭŜǎ ǎŜŎǘƛƻƴ ŦƻǊ 

ǇǊƻƎǊŀƳƳƛƴƎΦ /ƘƻƻǎŜ tǊƻŎŜǎǎ Ҕ  wǳƴΦ   

 

Figure 3.14. Generate Programming File in Lattice Diamond 

In Radiant software, from the Process Toolbar, click Export Files (Figure 3.15). 
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Figure 3.15. Generate Programming File in Lattice Radiant 

The Programming file is generated. The generated programming file can be used in the Programmer. 

3.2.4. Generating System Environment by Building Project 

System environment package including the system environment file and the BSP package is required for the embedded 
C/C++ project. 

To generate system environment package from Propel:  

1. Lƴ ǘƘŜ tǊƻƧŜŎǘ 9ȄǇƭƻǊŜǊ ǾƛŜǿΣ ǎŜƭŜŎǘ ŀ {ƻ/ ǇǊƻƧŜŎǘΦ 

2. /ƘƻƻǎŜ tǊƻƧŜŎǘ Ҕ .ǳƛƭŘ tǊƻƧŜŎǘΦ 

3. /ƘŜŎƪ ǘƘŜ ōǳƛƭŘƛƴƎ ǊŜǎǳƭǘ ƛƴ ǘƘŜ /ƻƴǎƻƭŜ ǾƛŜǿ όCƛƎǳǊŜ оΦмсύΦ 

 

Figure 3.16. Build Result of SoC Project 

3.2.5. About SoC Design Project 

The SoC project creating starts with a functional-ready SoC design and a default simulation environment. In the Project 
Explorer view, open a SoC project folder and all its sub-folders. The project contains (but is not limited to) the following 
files (Figure 3.17), some of which may vary upon your opening the SoC design project in Diamond or Radiant software: 
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¶ <proj_name>: Folder contains a Propel Builder design including the .sbx file. 

¶ <proj_name>/application: Folder contains functional-ready embedded application source codes.  

¶ impl1: Folder contains the implementation of Diamond/Radiant project. 

¶ sge: Folder contains generated package necessary for creating C/C++ project.  

¶ verification: Folder contains the SoC verification project. 

¶ verification/sim: Folder contains the simulation environment. 

¶ <proj_name>.ldf: Diamond project file. 

¶ <proj_name>.lpf: Diamond project logical preference file. 

¶ <proj_name>.rdf: Radiant project file. 

¶ <proj_name>.pdc: Radiant project post-synthesis constraints. 

¶ <proj_name>.txt: Description file from the template. 

 

Figure 3.17. Contents of SoC Project 
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3.3. C/C++ Project Design Flow 

3.3.1. Creating a Lattice C/C++ Project 

To start a Lattice C/C++ Project from Propel: 

1. /ƘƻƻǎŜ CƛƭŜ Ҕ bŜǿ Ҕ  [ŀǘǘƛŎŜ /κ/ҌҌ tǊƻƧŜŎǘΦ  

¢ƘŜ /κ/ҌҌ tǊƻƧŜŎǘ ǿƛȊŀǊŘ ƻǇŜƴǎ ǿƛǘƘ ǘƘŜ [ƻŀŘ {ȅǎǘŜƳ ŀƴŘ .{t ǇŀƎŜ όCƛƎǳǊŜ оΦмуύΦ 

 

Figure 3.18. Load System and BSP Dialog 

2. .ǊƻǿǎŜ ǘƻ ǘƘŜ {ƻ/ ǇǊƻƧŜŎǘ ŦƻƭŘŜǊ ŀƴŘ ǎŜƭŜŎǘ ǘƘŜ ǎȅǎǘŜƳ ŜƴǾƛǊƻƴƳŜƴǘ ŦƛƭŜ ǎȅǎψŜƴǾΦȄƳƭΦ  

!ƭƭ ǎȅǎǘŜƳ ŜƴǾƛǊƻƴƳŜƴǘ ŦƛƭŜǎ ŀǾŀƛƭŀōƭŜ ƛƴ ǘƘŜ ŎǳǊǊŜƴǘ ǿƻǊƪǎǇŀŎŜ Ŏŀƴ ōŜ ǎŜƭŜŎǘŜŘ ŦǊƻƳ ǘƘŜ {ȅǎǘŜƳ ŜƴǾΥ ŘǊƻǇπŘƻǿƴ 
ƳŜƴǳΦ 

3. LŦ ǘƘŜ ǇƭŀǘŦƻǊƳ Ƙŀǎ ƳƻǊŜ ǘƘŀƴ ƻƴŜ ǇǊƻŎŜǎǎƻǊΣ ŎƘƻƻǎŜ ƻƴŜ ŎƻǊŜΦ 

4. /ƘƻƻǎŜ ǘƘŜ ǇǊƻƧŜŎǘ ǘȅǇŜΣ / ƻǊ /ҌҌΦ 

5. 9ƴǘŜǊ ŀ ǇǊƻƧŜŎǘ ƴŀƳŜΦ {ǳƎƎŜǎǘ ƴƻǘ ǳǎƛƴƎ ǇŜǊƛƻŘǎΣ ŎƻƭƻƴǎΣ ƻǊ ǎǇŀŎŜǎ ƛƴ ȅƻǳǊ ǇǊƻƧŜŎǘ ƴŀƳŜΦ ¢ƘƻǳƎƘ ǎǇŀŎŜǎ ŀǊŜ 
ŀƭƭƻǿŜŘΣ ǘƘŜȅ Ƴŀȅ ŎŀǳǎŜ ŎŜǊǘŀƛƴ ƛǎǎǳŜ ǿƛǘƘ ǎƻƳŜ ǘƻƻƭǎΦ  

6. .ȅ ŘŜŦŀǳƭǘΣ ǘƘŜ ¦ǎŜ ŘŜŦŀǳƭǘ ƭƻŎŀǘƛƻƴ ƻǇǘƛƻƴ ƛǎ ŎƘŜŎƪŜŘΦ ¢ƘŜ ŘŜŦŀǳƭǘ ŦƛƭŜ ǎȅǎǘŜƳ ƛǎ ǎŜƭŜŎǘŜŘ ŀǳǘƻƳŀǘƛŎŀƭƭȅΦ {ǳƎƎŜǎǘ 
ǳǎƛƴƎ ǘƘŜ ŘŜŦŀǳƭǘ ƭƻŎŀǘƛƻƴ ǳƴƭŜǎǎ ȅƻǳ ƘŀǾŜ ǎǇŜŎƛŀƭ ƴŜŜŘ ǘƻ ŀ ǎǇŜŎƛŀƭ ƭƻŎŀǘƛƻƴΦ 
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7. /ƭƛŎƪ bŜȄǘΦ  

¢ƘŜ [ŀǘǘƛŎŜ ¢ƻƻƭŎƘŀƛƴ {ŜǘǘƛƴƎ ŘƛŀƭƻƎ ƻǇŜƴǎ όCƛƎǳǊŜ оΦмфύΦ 

  

Figure 3.19. Lattice Toolchain Setting Dialog 

8. .ȅ ŘŜŦŀǳƭǘΣ ǘǿƻ ǘƻƻƭŎƘŀƛƴ ŎƻƴŦƛƎǳǊŀǘƛƻƴ ƳƻŘŜǎΣ 5ŜōǳƎ ŀƴŘ wŜƭŜŀǎŜΣ Ŏŀƴ ōŜ ŎƘƻǎŜƴ ŦǊƻƳ ǘƘŜ /ƻƴŦƛƎǳǊŀǘƛƻƴ 
ŘǊƻǇπŘƻǿƴ ƳŜƴǳΦ  

¶ 5ŜōǳƎ ŎƻƴŦƛƎǳǊŀǘƛƻƴ ŎǊŜŀǘŜǎ ŜȄŜŎǳǘŀōƭŜǎ ŎƻƴǘŀƛƴƛƴƎ ŀŘŘƛǘƛƻƴŀƭ ŘŜōǳƎ ƛƴŦƻǊƳŀǘƛƻƴ ǘƘŀǘ ƭŜǘǎ ǘƘŜ ŘŜōǳƎƎŜǊ ƳŀƪŜ 
ŘƛǊŜŎǘ ŀǎǎƻŎƛŀǘƛƻƴǎ ōŜǘǿŜŜƴ ǘƘŜ ǎƻǳǊŎŜ ŎƻŘŜ ŀƴŘ ǘƘŜ ōƛƴŀǊȅ ŦƛƭŜǎ ƎŜƴŜǊŀǘŜŘ ŦǊƻƳ ǘƘŜ ƻǊƛƎƛƴŀƭ ǎƻǳǊŎŜΦ  

¶ wŜƭŜŀǎŜ ŎƻƴŦƛƎǳǊŀǘƛƻƴ ǇǊƻǾƛŘŜǎ ǘƘŜ ǘƻƻƭǎ ǿƛǘƘ ƻǇǘƛƻƴǎ ǎŜǘǘƛƴƎ ǘƻ ŎǊŜŀǘŜ ŀƴ ŀǇǇƭƛŎŀǘƛƻƴ ǿƛǘƘ ǘƘŜ ōŜǎǘ 
ǇŜǊŦƻǊƳŀƴŎŜΦ 

¸ƻǳ Ŏŀƴ ƳƻŘƛŦȅ ŦǊŜǉǳŜƴǘƭȅπǳǎŜŘ ƭƛōǊŀǊȅΣ ŎƻƳǇƛƭŜǊΣ ŀƴŘ ƭƛƴƪŜǊ ƻǇǘƛƻƴǎ ŦƻǊ ŜŀŎƘ ŎƻƴŦƛƎǳǊŀǘƛƻƴΦ CƻǊ ŀ ŎƻƳǇƭŜǘŜ 
ǘƻƻƭŎƘŀƛƴ ǎŜǘǘƛƴƎΣ Ǝƻ ǘƻ ǇǊƻƧŜŎǘ ǇǊƻǇŜǊǘƛŜǎ ŀŦǘŜǊ ŎǊŜŀǘƛƴƎ ǘƘŜ ǇǊƻƧŜŎǘΦ wŜŦŜǊ ǘƻ ǘƘŜ !ŘǾŀƴŎŜŘ ¢ƻƻƭ /Ƙŀƛƴ {ŜǘǘƛƴƎ 
ǎŜŎǘƛƻƴΦ 

¶ Lƴ [ƛō {ŜǘǘƛƴƎ ǘŀōΣ ǎǘŀƴŘŀǊŘ / ƭƛōǊŀǊȅ Ŏŀƴ ōŜ ǊŜŎƻƴŦƛƎǳǊŜŘΦ tƛŎƻƭƛōŎ ό/ [ƛōǊŀǊƛŜǎ ŦƻǊ {ƳŀƭƭŜǊ 9ƳōŜŘŘŜŘ {ȅǎǘŜƳǎύ 
ƛǎ ǎŜƭŜŎǘŜŘ ōȅ ŘŜŦŀǳƭǘ ŀƴŘ ƛǘ ǎǳǇǇƻǊǘǎ ŘƛŦŦŜǊŜƴǘ ǇǊƛƴǘŦ ƭŜǾŜƭǎΦ 

¶ Lƴ /κ/ҌҌ /ƻƳǇƛƭŜǊ ǘŀōΣ ƻǇǘƛƳƛȊŀǘƛƻƴ ƭŜǾŜƭ ŀƴŘ ŘŜōǳƎ ƭŜǾŜƭ Ŏŀƴ ōŜ ǊŜŎƻƴŦƛƎǳǊŜŘ ŦƻǊ ŜŀŎƘ ǘƻƻƭŎƘŀƛƴ 
ŎƻƴŦƛƎǳǊŀǘƛƻƴΦ  

¶ Lƴ /κ/ҌҌ [ƛƴƪŜǊ ǘŀōΣ wŜƳƻǾŜ ǳƴǳǎŜŘ ŎƻŘŜ όππƎŎπǎŜŎǘƛƻƴǎύ ƛǎ ŎƘŜŎƪŜŘ ōȅ ŘŜŦŀǳƭǘ ŦƻǊ ƎŀǊōŀƎŜ ŎƻƭƭŜŎǘƛƻƴ ƻŦ ǳƴǳǎŜŘ 
ŎƻŘŜΦ 

9. /ƭƛŎƪ CƛƴƛǎƘΦ 
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¢ƘŜ [ŀǘǘƛŎŜ /κ/ҌҌ ǇǊƻƧŜŎǘ ƛǎ ŎǊŜŀǘŜŘ ŀƴŘ ƛǎ ŘƛǎǇƭŀȅŜŘ ǳǎƛƴƎ ǘƘŜ tǊƻǇŜƭ {5Y ǇŜǊǎǇŜŎǘƛǾŜΦ ! ǇŜǊǎǇŜŎǘƛǾŜ ƛǎ ŀ ŎƻƭƭŜŎǘƛƻƴ 
ƻŦ ǘƻƻƭ ǾƛŜǿǎ ŦƻǊ ŀ ǇŀǊǘƛŎǳƭŀǊ ǇǳǊǇƻǎŜΦ ¢ƘŜ tǊƻǇŜƭ {5Y ǇŜǊǎǇŜŎǘƛǾŜ ƛǎ ŦƻǊ ŎǊŜŀǘƛƴƎ [ŀǘǘƛŎŜ /κ/ҌҌ ǇǊƻƎǊŀƳǎΦ 

3.3.2. Updating a Lattice C/C++ Project 

When you make changes to a SoC project, sometimes you want to synchronize the changes to an existing Lattice C/C++ 
project instead of creating a new Lattice C/C++ project. In this case, you can use the update C/C++ project feature. 

Note: This feature overwrites the corresponding files or settings of your existing C/C++ project. Be sure to back up your 
C/C++ project before using this feature.  

To update a Lattice C/C++ Project from Propel: 

1. DŜƴŜǊŀǘŜ ǘƘŜ ƭŀǘŜǎǘ ǎȅǎǘŜƳ ŜƴǾƛǊƻƴƳŜƴǘ ǇŀŎƪŀƎŜ ŀŎŎƻǊŘƛƴƎ ǘƻ ǘƘŜ DŜƴŜǊŀǘƛƴƎ {ȅǎǘŜƳ 9ƴǾƛǊƻƴƳŜƴǘ ōȅ .ǳƛƭŘƛƴƎ 
tǊƻƧŜŎǘ ǎŜŎǘƛƻƴΦ 

2. Lƴ ǘƘŜ tǊƻƧŜŎǘ 9ȄǇƭƻǊŜǊ ǾƛŜǿΣ ǎŜƭŜŎǘ ŀ /κ/ҌҌ ǇǊƻƧŜŎǘΦ 

3. Choose Project > Update Lattice C/C++ PǊƻƧŜŎǘΧ. 

The C/C++ Project wizard opens for updating system and BSP (Figure 3.20). 

 

Figure 3.20. Update System and BSP Dialog 

4. Browse to the SoC project folder and select the system environment file sys_env.xml.  

5. Select the checkbox for what you can update: 

¶ wŜπƎŜƴŜǊŀǘŜ ǘƻƻƭŎƘŀƛƴ ǇŀǊŀƳŜǘŜǊǎ ŀƴŘ ƭƛƴƪŜǊ ǎŎǊƛǇǘΥ ŎƘŜŎƪ ǘƘƛǎ ƻǇǘƛƻƴ ƛŦ ȅƻǳ ǿŀƴǘ ǘƻ ƳƻŘƛŦȅ /t¦ ƻǊ ƳŜƳƻǊȅ ƛƴ 
ǘƘŜ ǎȅǎǘŜƳΦ 

¶ ¦ǇŘŀǘŜ .{t ǇŀŎƪŀƎŜΥ ŎƘŜŎƪ ǘƘƛǎ ƻǇǘƛƻƴ ƛŦ ȅƻǳ ǿŀƴǘ ǘƻ ŀŘŘ ŀŘŘƛǘƛƻƴŀƭ Lt ŎƻƳǇƻƴŜƴǘǎ ƛƴǘƻ ǘƘŜ ǎȅǎǘŜƳΦ  

6. Click Update to make changes for the selected C/C++ project. 
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3.3.3. Building a Lattice C/C++ Project 

To build a Lattice C/C++ project in Propel: 

1. Lƴ ǘƘŜ tǊƻƧŜŎǘ 9ȄǇƭƻǊŜǊ ǾƛŜǿΣ ǎŜƭŜŎǘ ŀ /κ/ҌҌ ǇǊƻƧŜŎǘΦ 

2. Cƻƭƭƻǿ ǎǘŜǇǎ ōŜƭƻǿ ƛŦ ȅƻǳ ǿŀƴǘ ǘƻ ŎƘŀƴƎŜ ǘƘŜ ŀŎǘƛǾŜ ōǳƛƭŘ ŎƻƴŦƛƎǳǊŀǘƛƻƴΥ 

a. Choose tǊƻƧŜŎǘ Ҕ .ǳƛƭŘ /ƻƴŦƛƎǳǊŀǘƛƻƴǎ Ҕ aŀƴŀƎŜΧ. Or, click the Configuration icon  on the toolbar. 

b. The Manage Configurations dialog opens (Figure 3.21) for choosing active configuration. By default, a Debug 
configuration creates executables containing additional debug information that lets the debugger make direct 
associations between the source code and the binary files generated from the original source. A Release 
configuration provides the tools with options setting to create an application with the best performance. 

 

Figure 3.21. Manage Configurations Dialog 

3. /ƘƻƻǎŜ tǊƻƧŜŎǘ Ҕ .ǳƛƭŘ tǊƻƧŜŎǘΦ hǊΣ ŎƭƛŎƪ ǘƘŜ .ǳƛƭŘ ƛŎƻƴ    ƻƴ ǘƘŜ ǘƻƻƭōŀǊΦ 

4. ¢ƘŜ ǊŜǎǳƭǘǎ ƻŦ ǘƘŜ ōǳƛƭŘ ŎƻƳƳŀƴŘ ŀǊŜ ŘƛǎǇƭŀȅŜŘ ƛƴ ǘƘŜ /ƻƴǎƻƭŜ ǾƛŜǿ όCƛƎǳǊŜ оΦннύΦ 

 

Figure 3.22. Build Result of C/C++ Project 

3.3.4. About Lattice C/C++ Project 

The Lattice C/C++ project starts with source code. In the Project Explorer view, open a C/C++ project folder and all its 
sub-folders. The project contains: 

¶ src/bsp/driver: Folder contains driver codes from the IP in the platform. 

¶ src/bsp/sys_platform.h: Header file that defines DEVICE_FAMILY (the Lattice FPGA), address mapping, and any IP 
parameters that can be used by the drivers. 

¶ src/main.c: Source file contains the main routine, which is the entry-point of a C/C++ program.  

¶ src/cpu0.svd: System view description file used for peripherals registers view at debug perspective. 
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¶ src/cpu0.yaml: Processor description file used at debugging time. 

¶ src/linker.ld: Linker script file. 

¶ src/sys_env.xml: System environment file describing aspects of the platform, such as memory spaces. 

After building the project, the build output can be found in each build configuration folder, the Debug folder or the 
Release folder (Figure 3.23). The Debug or Release folder contains: 

¶ <proj_name>.elf: Executable file used in on-chip debugging. 

¶ <proj_name>.bin: Binary file used in deploying the application to flash memory. 

¶ <proj_name>.lst: Extended listing file generated by tool objdump.  

¶ <proj_name>.map: Linker map file. 

¶ <proj_name>.mem: Lattice system memory initialization file used in System_Memory IP. 

Note: Some of the files listed in Figure 3.23 are intermediate files that you do not need to take care of. 

  

Figure 3.23. Contents of C/C++ Project 

3.3.5. Writing Code 

Lattice Propel is based on Eclipse IDE. You can write application code following the process and usage of the same tools 
as any in Eclipse IDE. You can get more detailed information regarding Eclipse IDE from the Propel online help.  
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For writing code, Lattice Propel SDK provides two extra aids: 

¶ Lattice System Platform: An overview of the processor platform can be displayed (Figure 3.24). 

¶ Linker Editor: An overview of the memory regions of linker script can be displayed. You can modify key linker 
parameters via the graphical interface (Figure 3.25). 

 

Figure 3.24. Lattice System Platform 

  

Figure 3.25. Linker Editor 
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3.3.6. Advanced Tool Chain Setting 

Follow the process below to modify the tool chain settings of a C/C++ project. 

To change tool chain setting in Project Properties in Propel: 

1. Lƴ ǘƘŜ tǊƻƧŜŎǘ 9ȄǇƭƻǊŜǊ ǾƛŜǿ ƻŦ tǊƻǇŜƭΣ ǎŜƭŜŎǘ ŀ /κ/ҌҌ ǇǊƻƧŜŎǘΦ 

2. /ƘƻƻǎŜ tǊƻƧŜŎǘ Ҕ tǊƻǇŜǊǘƛŜǎΦ ¢ƘŜ tǊƻǇŜǊǘƛŜǎ ŦƻǊ ŎǳǊǊŜƴǘ ǇǊƻƧŜŎǘ ƻǇŜƴǎ όCƛƎǳǊŜ оΦнсύΦ 

3. {ŜƭŜŎǘ {ŜǘǘƛƴƎǎ ƻŦ /κ/ҌҌ .ǳƛƭŘ ŎŀǘŜƎƻǊȅ ŦǊƻƳ ǘƘŜ ƭŜŦǘ ǇŀƴŜΦ {ŜƭŜŎǘ ǘƘŜ ¢ƻƻƭ {ŜǘǘƛƴƎǎ ǘŀōΦ 

 

Figure 3.26. Properties of C/C++ Project 

4. /ǳǎǘƻƳƛȊŜ ǘƘŜ ǘƻƻƭǎ ŀƴŘ ǘƻƻƭ ƻǇǘƛƻƴǎΦ !ƭƭ ȅƻǳǊ ŎǳǎǘƻƳƛȊŀǘƛƻƴ Ŏŀƴ ōŜ ǊŜǎǳƭǘŜŘ ƛƴ ǘƘŜ ōǳƛƭŘ ŎƻƴŦƛƎǳǊŀǘƛƻƴ ƛƴ ǘƘŜ ¢ƻƻƭ 
{ŜǘǘƛƴƎǎ ǇǊƻǇŜǊǘƛŜǎ ǘŀōΦ ¢ƘŜ ōǳƛƭŘ ŎƻƴŦƛƎǳǊŀǘƛƻƴ ƛǎ ǳǎŜŘ ŘǳǊƛƴƎ ȅƻǳǊ /κ/ҌҌ ǇǊƻƧŜŎǘ ōǳƛƭŘƛƴƎΦ  

Note: The setting for each configuration, Debug or Release, is independent. 

5. /ƭƛŎƪ !ǇǇƭȅ ŀƴŘ /ƭƻǎŜ ǘƻ ǎŀǾŜ ǘƘŜ ŎƘŀƴƎŜΦ 

Note: You may need to clean the project to make the new setting take effect for the whole project.   
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3.4. System Simulation Flow 
The SoC Project created from template has a default simulation environment for you to setup and start functional 
simulation. It is generated automatically along with the SoC project creation. You can use it as a start point and 
customize accordingly. 

The default simulation environment is with the following features: 

¶ Provides similar user experience as real board-level debugging, such as for Hello World SoC, key components 
including RISC-V MC, System memory, and UART. 

¶ Simulates user-modified template SoC with extended HDL designs. 

¶ Simulates the whole system using real C/C++ projects as stimulus with the necessary modification and with all the 
details for debugging. 

¶ Supports user extension with a friendly and flexible approach. 

3.4.1. Launch Simulation 

To launch simulation: 

1. Lƴ tǊƻǇŜƭ .ǳƛƭŘŜǊΣ ǳǇŘŀǘŜ ǘƘŜ {ƻ/ ŘŜǎƛƎƴ ǘƻ ŜƴŀōƭŜ ǎƛƳǳƭŀǘƛƻƴ ŦŜŀǘǳǊŜǎΦ 

¶ 9ƴŀōƭŜ ǘƘŜ ŎƘŜŎƪōƻȄ ŦƻǊ {ƛƳǳƭŀǘƛƻƴ aƻŘŜΣ ŀƴŘ ŘƛǎŀōƭŜ ǘƘŜ ŎƘŜŎƪōƻȄ ŦƻǊ 5ŜōǳƎ 9ƴŀōƭŜ ŦƻǊ wL{/π± a/ Lt 
ƳƻŘǳƭŜ ƛƴ ǘƘŜ DŜƴŜǊŀƭ ŀǊŜŀ όCƛƎǳǊŜ оΦнтύΦ 

  

Figure 3.27. Configure Module RISC-V MC 
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¶ 9ƴŀōƭŜ ǘƘŜ ŎƘŜŎƪōƻȄ ŦƻǊ LƴƛǘƛŀƭƛȊŜ aŜƳƻǊȅ ŦƻǊ ǎȅǎǘŜƳψƳŜƳƻǊȅ Lt ƳƻŘǳƭŜ ŦǊƻƳ ǘƘŜ LƴƛǘƛŀƭƛȊŀǘƛƻƴ ŀǊŜŀ ƻŦ ǘƘŜ 
DŜƴŜǊŀƭ ǘŀōΣ ŀƴŘ ǎŜǘ LƴƛǘƛŀƭƛȊŀǘƛƻƴ CƛƭŜ ƎŜƴŜǊŀǘŜŘ ŦǊƻƳ ǘƘŜ ŎƻǊǊŜǎǇƻƴŘƛƴƎ /κ/ҌҌ ǇǊƻƧŜŎǘ όCƛƎǳǊŜ оΦнуύΦ 

   

Figure 3.28. Configure Module System Memory 

2. /ƭƛŎƪ ǘƘŜ {ǿƛǘŎƘ ƛŎƻƴ ƻƴ ǘƘŜ ǘƻƻƭōŀǊ ǘƻ ǎǿƛǘŎƘ ōŜǘǿŜŜƴ {ƻ/ ŘŜǎƛƎƴ ŀƴŘ {ƻ/ ǾŜǊƛŦƛŎŀǘƛƻƴ ǇǊƻƧŜŎǘ όCƛƎǳǊŜ оΦнфύΦ 

3. !ŦǘŜǊ ǘƘŜ {ƻ/ ŘŜǎƛƎƴ ƛǎ ǎǿƛǘŎƘŜŘ ǘƻ ŀ {ƻ/ ǾŜǊƛŦƛŎŀǘƛƻƴ ǇǊƻƧŜŎǘΣ ŎƭƛŎƪ ǘƘŜ DŜƴŜǊŀǘŜ ƛŎƻƴ  ǘƻ ƎŜƴŜǊŀǘŜ ǘƘŜ ǎƛƳǳƭŀǘƛƻƴ 

ŜƴǾƛǊƻƴƳŜƴǘ ŦƻǊ h9a aƻŘŜƭ{ƛƳΦ /ƭƛŎƪ ǘƘŜ [ŀǳƴŎƘ {ƛƳǳƭŀǘƛƻƴ ƛŎƻƴ  όCƛƎǳǊŜ оΦнфύΦ 
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Figure 3.29. SoC Verification Project 

4. aƻŘŜƭ{ƛƳ ƛǎ ƭŀǳƴŎƘŜŘ ǊǳƴƴƛƴƎ ǎƛƳǳƭŀǘƛƻƴ ŦƻǊ ǘƘŜ {ƻ/ ǾŜǊƛŦƛŎŀǘƛƻƴ ǇǊƻƧŜŎǘΦ ¢ƘŜ ŎƻǊǊŜǎǇƻƴŘƛƴƎ ǿŀǾŜŦƻǊƳ ƻŦ ǘƘŜ {ƻ/ 
ǾŜǊƛŦƛŎŀǘƛƻƴ ǇǊƻƧŜŎǘ ŦƻǊ ǘƘŜ IŜƭƭƻ ²ƻǊƭŘ ǇǊƻƧŜŎǘ ƛǎ ǎƘƻǿƴ όCƛƎǳǊŜ оΦолύΦ /ƘŜŎƪ ǘƘŜ ǿŀǾŜŦƻǊƳΦ  

 

Figure 3.30. Waveform of Hello World Project 

3.4.2. Simulation Details 

The default simulation environment is located at the generated sim folder inside the SoC verification project in Propel. 
It contains: 

 

You can extend more verification features in the top testbench. 

[sim]                                           -- generated simulation environment 
         [hdl_header] 

soc_regs.v              -- register definitions of all the components in DUT/SOC 
sys_platform.v      -- base address, user settings of all the components in DUT/SOC 

         [misc] 
*.*                           -- all the mem, hex, txt files will be copied here 

                  flist.f                                 -- file list for HDLs 
                  msim.do                           -- do script for simulator, it can be qsim for Questasim 
                  wave.do                           -- do script for adding signals in waveform window 
                  <project_name>.sv        -- top testbench, SystemVerilog based 
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